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1. Introduction

11 Purpose

SWE-60 is an application which runs on the CW100-03 Cerberus Service tool (notebook/laptop).

The tool supports configuration and parameterization, and also data backup for the CC-60 gas detec-
tion system control unit.

The program is largely linked into the existing CS menu shell (SWE menu) and has been adapted to
this specification.

1.2 User interface

The user interface is adapted as far as possible to the CS standard (MODULA-2 mode interface).
Thus the tool is defined to be usable with an SAA window-oriented user interface.

Deviations from standard CS operation are described in this user manual.

The user interface has been developed to allow extremely simple language adaptations.

1.3 User profile

The user group is defined as consisting of the service engineers, project members and construction
site supervisors. The user interface has thus been defined according to the CS standard. The project
member and construction site supervisor will typically use the tool in the office to pre-program a gas
detection system. The service engineer will typically use the tool on the customer's site for servicing
and commissioning work on gas detection systems.

1
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1.4 System requirements

The tool requires the following platform as a minimum configuration:

Computer : IBM AT (or compatible)
Operating system : MS-DOS/PC-DOS v6.2x
RAM : at least 550 KB free memory
EM 368.exe — disabled
Smart drive — disabled
Mass storage :HD/FD
Screen :CGA/EGA/VGA
Keyboard : PC/ XT / AT, mouse optional
Interfaces : 1 x RS232, 1 Centronics
Copy protection : protected by dongle on LPT1
Accessory : B3D021 modem with data cable
1.4.1 Ordering information
Item Part no Designation
SWE 60-01 — 0SS Parameter editor for SWE 60
M3C 060 462088 DONGLE D FULL
B3D 021 505259 V24 DUAL MODEM
AT CABLE 427667 AT cable 9f/25m; L=0.25m
- 417279 Cable 25f/25m; L=2m Ribbon
- 466453 AT modem cable 25m/9f / L=4.5m
- 433842 MONITOR CABLE 9f / 9m./ L=3m
1.5 Starting SWE-60
The program is always started from the CS menu shell (SWE).
The program is started using the command "SWEG0" (Cerberus specification batch file).
The program will not run unless the dongle (M3 C060 / CC60 / 462 075 CS specified) is connected to
the computer's printer port.
1.6 Operation
The program is operated through the keyboard using hotkeys, function keys and the tab key.
The program optionally supports a mouse on the serial ports COM1 or COM2.
The dialogue language is the national language of the installation country, this can be selected in a
configuration file.
See the Cerberus guidelines and the operating element listed in the documents "PC Setup / Installati-
on / Operation" (€996a) and "SWUDSK" (€969a) for further operations. (Documentation in "SWTS 60"
file)
2
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2. Starting SWE60 menu shell

21 Opening screen

The opening screen appears once the SWEGO tool is started from the Cerberus menu shell.

The dropdown menus can be opened using the <Ins> key.

Windouws Allgemein S5ite Disk System Editor

CERBERUS Command 3hell : Danger detection control wunit CCead

actual site
Start : use
End : use
Version 1.3

drive 7 directoru: RA:

key <Ins> (or mousel to pull dowun menus

command "EXIT" in HEHU "General'" to return/quit
of 19-Harch-97

2.2 Menu "General"

An information box can be opened under the "General" menu. The User Manual is opened under

"Manual".

SWEGO is also closed by selecting "End" in this menu.

Windouws Allgemein S5ite Disk System Editor

CERBERUS Command 3Shell :: Danger detection control wunit CCead

actual site
Start : use
End : use
Uersion 1.3

drive /7 directory: A:

key <Ins> (or mousel to pull dowun menus

command "“"EXIT" 1n HEHU "General'" to return/quit
of 19-March-—-97
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23 Menu "System Disk"

Windouws Allgemein S5ite Disk System Editor

Prepare site disk
Start SWUDSK

Directory of disk
List all files

Make a copy of disk

Format disk 72Z0KB

CERBERUS Command Shell : Danger detection control wunit CCaO

actual site drive ¥ directory: A:

Start : use key <Ins> (or mousel) to pull dowun menus

End : use command "EXIT" 1in MEHU "General" to return/quit
Uersion 1.3 of 19-March-97

A system disk must first be created using the SWUDSK program before the SWEG60 system editor can
be started.
The functions of the SWUDSK program are described in document "SWUDSK" €969a.

24 SWE 60 system editor

Sustem Editor

Start Editor 3SWEGO0

Up— and Download Utility CCaO

Start CC 60

CERBERUS Command Shell : Danger detection control wunit CCead

actual site drive / directory: A:

S5tart : use key <Ins> (or mouse) to pull dowun menus

End : use command "EXIT" in HEHU "General" to return/quit
Uersion 1.3 of 19-Harch—97

The opening screen is displayed when the SWEB0 system editor is started. It includes all the instructi-
ons necessary for the functions of the SWEG60 system editor. These include, e.g., the presence of the
dongle (M3CO060) in the parallel port, the installation diskette in drive "A", etc.

4
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3. SWE60 system editor functions
3.1 General and Operation

Press the <F10>function key or the key combination <Alt> and <hotkey> to open a dropdown menu.

A menu item in a dropdown menu may be selected with the <up/down arrow key>, and opened with
the <Spacebar> or the <Enter> key.

The parameters within a menu item available for editing may be selected with the <tab key>.
The edited data can be accepted by selecting the "OK" button and pressing the <Spacebar> or
<Enter>.

To discard the parameters, select the "CANCEL" button and press the <Spacebar> or <Enter>.

3.2 SWE system editor menu interface
General Control unit File Edit §:20:11

When the system editor is started, a menu bar with the options General, Control unit, File and Edit is
displayed. The Edit option can only be activated after opening a new or existing system. The functions
for the various options are described below.

5
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3.3 Menu "General"

About

Setup

[

Quit ALT+Q

General Control uwnit File

Edit

§:23:33

This menu includes the functions "About® for the SWEG60 system editor, “Setup” and "Quit" which you
can use to leave the system editor.

3.3.1 Setup

Use the "Setup" function to change the screen from monochrome to color display. Any printer port will

be configured here.

Edit

General Control uvnit File

Ahout

Setup 2 Display Hono
Display Colour

Quit ALT+N

Printer

[

8:23:47

6
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3.3.2 Printer

The parallel or serial port is configured under the function "Selection®.

General Control unit File Edit 8:24:05
About
Setup 2 Display Mono
Display Colour
Quit ALT+Q
Printer > Selection
Setup Printer
The port can be selected under the function "Port"
General Control unit File Edit 8:24:26
SELECT PRIHNTER
Printer Port
EPSON compatible (+) LPTI1. .31
CERBERUS serial (G OK »
CANCEL >
hprt
The port desired can be selected using the <cursor keys> and confirmed with the
<Tab key> by selecting "OK".
Note:  The printer driver CWPRINT.EXE, which is located in c:\swe60\sys will be
used for printing.
7
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34 Menu "Control unit"
General Control uvunit File Edit 8:25:01

Data transfer CC -> SUWE
Data transfer SWE -> CC

SW Update

The "Control unit" menu is used for communication with the CC60 control unit. Communication can ta-
ke place in both directions : Data can be transmitted from the control unit to the PC, and vice versa.

3.41 Data transfer CC ---> SWE

Data is transferred from the control unit to the PC to back up the data on the system. In order to carry
out the backup procedure, you must first use the selector box to specify the file in the appropriate di-
rectory in which the control unit data will be saved.

General Control unit File Edit 8:25:728

TRANSFER CCe0 >> SWEGD

[ =

< CANCEL >

A:N

filget

Note: If you choose an existing file, the existing parameters will be overwritten.

8
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Once you have selected the file and confirmed with <Enter>, you are automatically to the port definiti-
on. In this function you must select the serial port "Com no." and specify the "Baud rate" on the PC

General Control uvunit File Edit 8:20:51

SERIAL PORT

COM no. : 1

Baud rate : 9600

« 1] »

txport

Note: A percentage bar, representing the data transfer will appear on screen if the communication
between the control unit and the PC is in order.

Requirement for data transmission:

1. PC connection for data backup
[ M3C060
: Parallelport
: . P5 RS232C
Mod
[ Pc ] . | Modem | o
Note: If the B3D021 modem is used
- Input A1/A2
- Output K1/K2

- Switch S1/S2 to position S (down)
2. Configuration of the CC60 control unit for data backup
1. Release operation, password 7000

2. F4 040 Service PC ON
3. F4 045 baud rate 9600

9
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3.4.2 Data transfer SWE ---> CC

Data is transferred between the PC and the control unit to load control unit parameterization which has

been configured on the PC.
To carry out control unit parameterization, you use first the selector box, select the file in the appro-

priate directory in which the control unit data are stored.

Caution: Any existing control unit parameters will be overwritten when a control unit is configured
through the PC!
General Control unit File Edit 8:29:57

TRANSFER SWEGD >> CCoO

— ]

< CANCEL >

A:N

filget

The remainder of the procedure is analogous to data backup, subclass 3.3.1

3.4.3 Software update

This function is not yet implemented!

10
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3.5 Menu "File"
General Control unit File Edit 8:30:14

New
Open
Save

Convert
Create List

Delete

In the "File" menu, parameters are set for new systems under "New", existing systems are edited un-
der "Open", the data are saved to disk under "Save", existing system parameters converted to a hig-
her software version under "Convert", the system parameters are printed out under "Create list" and
existing systems deleted under "Delete".

3.51 New
General Control unit File Edit 8:31:02
NEW FILE
A
>
« 1]:4 »
{ CANCEL >
A:\DEHO
filget

Parameters for a new system are set under File "New". All directories on the diskette previously pro-
duced using the SWUDSK program are listed in the file selector box. The directory in which the in-
stallation data is to be stored must first be selected. The system number without an extension must
then be entered in the input window. The control unit number is then the name of the file in which the

system data is stored.

11
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The following input screen appears once a file has been opened:

General Control unit File Edit 8:33:09
OPEN FILE
A:
A
’.
« 1] 4 »
< CANCEL >

A :\DEMO

filget

The missing data must now be added and the window closed by pressing <Enter>with the cursor on
the "OK" button.

3.5.2 Open
General Control uvunit File Edit 8:35:22
SAVE FILE
A:
A
>
« 1]:4 »
< CANCEL >
A:\DEHMD
filget

An existing system is opened under "Open". The directories present on the system diskette are listed
in the file selector box. When the directory to be used has been selected, the existing systems (control

unit numbers) are listed. The system is opened by selecting the "Open" button and confirming with
<Enter>.

Note: opening a system can take up to 5 minutes!

12
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3.5.3 Save

General Control unit File Edit 8:36:09
PRINT OUT

Systenm no.: A: Date : 2770471998
Control unit: DEHO
Type List to

“« [1]4 »
Document [X] Printer [1
Parts List [ 1 File [¥1 < CANCEL >

prisel

The system currently open is saved to disk with "Save". The directories present on the system diskette
are listed in the file selector box. Once the directory has been selected, the configuration must be sto-
red under the same file name (control unit number) as it was opened.

Caution: it’s forbidden to use file names with special signs like () /\-?*!

3.5.4 Convert

This function is not yet implemented!

13
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3.5.5 Create list

A listing for the system currently opened may be created using this function.

General

Control unit File Edit

New
Open
Save

Convert

Create List

Delete

G:30:14

It is only necessary to check the menu "File" if you wish only to create a data file. The "Printer" func-
tion must also be checked if you wish to print the system data.

Caution:  No listing can be created if no port has been selected for the printer under the General
menu.
General Control uvunit File Edit 8:36:09

PRIHT OUT

System no. : A: Date 27/704/1998
Control uwvnit: DEHMO
Type List to

-« DK =
Document [X1] Printer [ 1
Parts List [ 1 File [X1] |< CAHCEL >|

pritsel

The window illustrated below only appears if you are printing via the serial port.

Windouws

14
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DEVICE

Hetz LPTZ2..3:

Parallel PRH :
Seriell COH1:

Seriell COHZ:

FalsUCTW

Zeichensatz
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3.5.6 Delete

General Control unit File

Edit

DELETE FILE

A
« 1]:4 »
< CANCEL >

A

th

filget

8:36:37

Existing systems can be can be deleted with function "Delete". You must first select the appropriate di-
rectory before a system can be deleted. The relevant control unit number can be selected within the

directory and deleted by confirming the "Open" button by pressing <Enter>.

15
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3.6 Menu "Edit"
General Control vwnit File Edit 9:05:57

System parameters

Harduware

Interfaces

Detector Lines

Detector parameters

Copy function

Control Zones

A gas detection system is actually configured in the menu "Edit". This menu will not be active unless a
new system first has been created or an existing system has been

3.6.1 Operation - General

A parameter must be selected using the <Tab key> if you wish to edit it.

<Shift> and <Tab> takes you back one parameter.

Within an editable parameter you can use the <Cursor keys> to select the setting desired, which you
can then confirm with the <Spacebar>.

The confirmation is indicated by a point next to the setting selected.

Where a number of settings are possible for a parameter, but not listed on the screen, an appropriate
selection can be displayed by pressing the <Spacebar>.

16
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3.6.2 System parameters

All control unit-specific system data and all system times are configured under System parameters.

General Control uwnit File Edit 9:06:53
SYSTEH DATA

Language selection Mains freq.
Nat. language (-] 50Hz (-)
English € 6OHz ()
Passuord
Level B [7000]1 [7001]1 [7002]1 Validity 4 Min.
Level 1 [7100] [7101]1 [?102]1 Validity 4 Hin.
Level 2 [7200]1 [7201]1 [7202]1 Validity 4 Min.
UD6E Query withou.passu. Ye () Ho (+)
Access authoriz. F1+F2 LEVEL B
< SYSTEH TIHES > “ 0K = < CAHCEL >
sysdat

"Language selection™

This can be used to select the language to be used when working with the control unit. You always
have the option of selecting between the Default language of English and the national language stored
in the text EPROM in the control unit.

"Mains freq."
Setting the mains frequency according to national mains ratings.

"Password"

The control unit has three levels of hierarchy, each with three individually editable
passwords:

Level 0 = Service engineer

Level 1 = Unrestricted authority

Level 2 = Restricted authority

Itis also possible to specify the duration of the release (4-99 min. , or 999 for infinite).

"VD60 Query without passw."

This can be used to select whether the control unit parameters should be visible for viewing on the
control unit display (VD60) or not, without entering a password.

"Access authoriz. F1 + F2" is used to define from which password hierarchy on the control unit de-

tector on/off and detector test can be released.
Recommended : User with all rights

17
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3.6.2.1 System times

General Control unit File Edit 9:07:15
SYSTEH TIMES
System times Change time Day/Hight [HH:HM]
Date 2770471998 1st time 17:30 4th time 24:00
Tine 09:07 Znd time 24:00 5th time 24:00
Com.dat. 27/04/1998 Jrd time 24:00
Aut.det.0ON chang. NIGHT [ 1

Switchover dates
Summer/Winter [D/7HAY]

Switchover dates
Winter/Sunner [D/HAY]

CAK Delay times

1st date 21/09/1995
Znd date 21/09/1996

1st date 21/03/1995
2nd date 21/03/1996

Invest.time U1 [s] 120
Invest.time U2 [s] 4180

3rd date 21/09/1997 3rd date 21/03/1997 Warn. exp.VU2 [s] 60
4th date 21/09/1998 4th date 21/03/1998 Rem.aud.sig. [s] 3Joo
5th date 2170971999 5th date 21/03/1999

Mains fail.delay 0 sec

Time dat.check 10:00 C(HH:HH) 14 » < CANHCEL >

systime

"System times" is used to set the current date, the time of day and the date of commissioning in the
control unit.

The "Change time Day/Night" define when the switch-over from day to night operation (CAK) is to
take place.

With "Aut.det.ON chang. Night" is possible to configure whether detectors that have switched off
are to be switched on automatically during the switch-over from day to night.

Note : never switch on detectors automatically.

The "Switch-over dates" define the Summer/Winter and the Winter/Summer switchover times. At
least one switchover data must be defined for each occasion, otherwise a fault will be signaled on the
control unit.

The Cerberus-Alarm-Concept is set up using the "CAK Delay times".
With "Mains fail delay" the event of mains failure can be edited (0-10000 sec.).

The "Time dat. Check" specifies when any check on switch-over times has to be carried out.

18
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3.6.3 Hardware

General Control uvunit File Edit 9:09:54
HARDWARE DEFINITION
BUS slots Front elements
FE 1 [X]
BUS no. 12 () RK60O FE 2 [ 1
BUS no. 13 (+) AKGBO FE 3 [ 1
BUS no. 14 () -——= FE 4 [ 1
BUS no. 15 () -——=
BUS no. 16 ( ) -——=
BUS no. 17 ( ) - Keyh. f. fire stat.
BUS no. 18 ( ) -—=
BUS no. 19 ( ) -—= Yes )
No (+)
|
E4G0O30 &
E4G040 + 1
AKGO v « ok > < CANCEL >
hard

Note: "Hardware" specifies the hardware configuration to the control unit.

The "Bus slots" is used to configure the plug-in cards plugged into the sub-rack bus (G3E010). Pa-
rameterization must be carried out as follows:

1. The <Cursor keys> are used to select the BUS number to be configured, this is confirmed with the
<Spacebar>.

2. Use the <Tab key> to select the selector box showing the possible cards. Then you can select the
card required with the <Cursor keys> and confirm your choice with <Enter >.

The "Front elements" specifies to the control unit how many FE-60 are located on the control unit.
Later, in the assignment of the physical to the logical detector address, only those logical addresses
will be released that have been selected with the display elements.

The "Keyb. for fire stat" indicates whether a fire department control panel is fitted in the control unit.

Note: The E4G030 controller cards are automatically set on bus no. 18 and 19
if fire department control panel is set "Yes".

19

Siemens Building Technologies e1369e
Fire & Security Products 10.2002



3.6.4 Interfaces

:30

General Control unit File Edit 9:10
INTERFACES (5D
Service PC Remote display
On €] On €
off (+] off (+)
Baudrate 9600 Baudrate 2400
Printer Management Systenmn
NOT CONHECTED HOT CONHECTED
Location Adr. 0] « [OK =
Baudrate 2400 Baudrate 300
<CANCEL>
iface

The "Interfaces" function defines the interfaces on SU-60.

"Service PC" function specifies whether the Service PC interface is to be active or inactive. You also
define the corresponding transmission rate, which must be identical on the PC and the control unit. A
selection box can be opened by pressing <Space>

"Remote display" function is used to indicate whether further terminals (CT-60) are connected to the

control unit. (not currently available)

The "Printer" function is used to specify whether a Cerberus printer, a third-party printer or no printer

is connected to the control unit. A selection box can be opened by pressing <Space>

With the "Management system" function is the same way as for the printer, you can define whether
the control unit is to communicate with a management system.
A selection box can be opened by pressing <Space>
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3.6.5 Detection lines
General Control unit File Edit 9:11:00

DETECTOR LINES

Detector lines

LI6O-1
LI6O-2
LI60-3
LI6O-4

LOOP, LOCALLY

——
Sttt

STuB, LOCALLY
STUB., REHWOTE
LOOP, LOCALLY
LODP, REHWOTE

{CANCEL>

nelin

Note:  The "Detector lines" function is used to define the gas detector lines. This may be either a
stub line or a loop line. In addition, you are able to define whether the detectors are fed from
the control unit, or whether the detectors are supplied from outside.

"Detection lines" Parameterization is carried out as follows:
1. The <Cursor keys> are used to select the line interface to be configured, this is confirmed with
the <Spacebar>.

2. Use the <Tab key> to select the selector box showing the possible line types. Then you can se-
lect the line type required with the <Cursor keys> and confirm your choice with <Enter>.
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3.6.6 Detector parameters

AHNALOG OUTPUTS

General Control unit File Edit 9:12:35
DETECTOR PARAMETERS
ASSIGHHMENT CONFIGURATION RETENTIOHN
DETECTOR / FE BAR DISPLAY 0OF THE DISPLAY
<Edit> {Edit> {Edit>
GENERAL INUVERSION RELEASE DETECTORS
CONFIGURATION 0OF ALARHS (FAZUAAVA/AL)
<Edit> {Edit> {Edit>
SEHSOR TYPE CONFIGURATION COHCENTRATION

CALIBRATION GAS

{Edit> {Edit> {Edit>
THRESHOLD UALUES
SET (WA/VA/AL) {CONTIHNUE >

<Edit>

SENSOr

Note:

The menu is used as follows:

All detector-specific parameters are defined under this function "

Use the <Tab key> to select the field you wish to configure. Confirming by pressing <Enter>then ta-
kes you to the relevant submenu.

Recommendation:

left to right, and then from top to bottom.

3.6.6.1 ASSIGNMENT DETECTOR / FE

Parameterization must be carried out in sequence, first from

General

Control unit File

Edit

Detector position

DETECTOR PARAMETERS
ASSIGHMENT DETECTORS / FE

9:13:21

IIiI

Det.number(phys)

= =
+»FE101 - 101 a |101 101 (101) 4
FE10Z - 255 + 102 4
FE103 - 255 103
FE104 - 255 104
FE105 - 255 << Assign << 105
FE106 - 255 106
FE10? - 255 107
FE108 - 255 > Remove > 108
FE109 - 255 109
FE110 - 255 110 | « (K =
FE111 - 255 111
FE112 - 255 112
FE113 - 255 : 113 ¥ <CANCEL>
5_ass
L Sensor

II;J

"ASSIGNMENT DETECTOR / FE" is for the assignment of a physical detector address to a logical

address on the FE-60 display.

Select with the <Cursor keys> the detector position which a physical detector address is to be as-
signed. After them you must use the <Tab key> to switch to the "Detector number, phys" selector

box.
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Use the <Cursor keys> to select the physical detector address required. Pressing the <Tab key>
again selects the "Assign" field and the function is concluded by pressing <Enter>.

The assignment is now indicated at the detector position.
An assignment is deleted in exactly the same way, except that the "Remove" field is selected instead.

3.6.6.2 Bar display configuration

General Control unit File Edit 9:14:11
DETECTOR PARAHETERS

| ASSIGHHMENT | | CONFIGURATION | | RETENTION
BAR DISPLAY CONFIGURATIOHN
Pos. Stat. Start End
FE1081 - norm / 0/ 100
Normal ()
Inverse (]
start val. 0]

End value 100 Ii
|« 114 »

(FE 181) |< Ok >

<CANCEL>

s_balk

SeEnsor

"Bar display configuration" is used to define the resolution of the concentration indicator on the FE-
60 for each gas detector.

The resolution can be increased or reduced with a start value and end value. This is done by first se-
lecting the FE address desired in the selector box.

The bar display can also be set up to the inverse. This is useful if a purge process (e.g. O,) is to be
displayed.

23

Siemens Building Technologies e1369e
Fire & Security Products 10.2002



3.6.6.3 Alarm hold

General Control unit File Edit 9:15:31
DISPLAY RETENTIOH
Pos. FA WA PA AL

Fault self-hold Yes ()
FE 101 - H_ N_ N_ SH No (+)
Warning self-hold Yes ()
No (+)
Prealarm self-hold Yes ()
No (+)
Alarm self-hold Yes (+)
No ()

(FE 181) |< Ok >

[« ox = |<cencer>

s_hold

The "Retention of the Display" function is used to program whether the indication on the FE display is
to be holding /not holding for each event level and detector.

The following event levels for each detector can be programmed as holding or not holding:

- Faults
- Warning
- Prealarm
- Alarm

Caution:
controllers.

3.6.6.4 General configuration

(FA)

(WA)

(PA)
(AL)

Hold relates only to the display and has no impact on the relay

General Control unit File Edit 9:16:07
GENERAL DETECTOR CONFIGURATIO
Pos. Configuration
FE 101 - enabled
ENABLE blocked Yes ()
No (+)
Sensitivity A
Init.conmissioning 2770471993
Hext change P
Last calibration P
< 0k |
(FE 101) |< Ok >
<CANCEL>
s_specfyg

The "General configuration" function is used to define the calibration parameters for the gas detec-

tors.
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"ENABLE blocked" can be used to lock the selected detector out.
Caution: A detector must be set to Lock "No" for it to function.

With "Sensitivity" you can define the value (in % of the calibration value) below which a detector is
considered to be outside the tolerance during the test using calibration gas and is recorded as too in-
sensitive.

Important: It must not be changed !!

"Init commissioning" and "Next change" are entry of the corresponding data.
The periodicity of sensor change can be found in the maintenance documentation.

"Last calibration" can not be changed.

3.6.6.5 Inversion of alarms

General Control unit File Edit 9:16:38
IHUERSION OF ALARHS b
Pos. Type
FE 181 - normal

Normal (-) Inverse ()

Printer DHS

Fault [X] [X1
Warning [ 1] [¥]
Prealarn [1 [X1
Alarn [¥] [¥1
« 0K »
(FE 101) | Ok >
<CANCEL>
s_alinv L

This menu defines whether a detector is to be operated in the inverse (e.g. O,).

You can also define which event levels are to be transmitted to the printer or to the DMS. Make the
selection by pressing the <Spacebar>.
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3.6.6.6 Alarm release FA/WA/PA/AL

General Control uwnit File Edit 9:17:39
ALARH RELEASE i
Pos. FA WA UA AL

FAULT Yes (+)
FE 101 - % ) ) ¥ No )
WARNING Yes (-]
No )
PREALARH Yes (+)
No €
ALARH Yes (-]
No )

(FE 101) |< Ok >

|« 0K »| <CANCEL>

s_fre

This function is used to enable or block the Fault, Warning, Pre-alarm and Alarm event levels for
each detector. The selection is made with the <Spacebar>.

Note : Enable all event levels. Reporting of events can be suppressed in the zone
definition if it is not required.

3.6.6.7 Sensor type

General Control vnit File Edit 9:16:19
DETECTOR PARAMETERS

| ASSTGHHENT | | cowFIcuraTION | | RETENTION
SENSOR TYPE

Pos. Type FE101 Sensor types

*FE 101 - GSP60-01(Horm.) GSEGO-D6(NO)
GSEGO-0Z(CO)
GSE6O-OY(CLZ)
GSEGO-DBC(HOZ)
GSE60-14(03)
GSEBE-13CETD)
GSEBB-11(NH3)
G5P60-01(Horm.)
G5P60-02(Lead)
G5PB60-03(Spec.)

<CANCEL>

N -« I I - B

s_sentyp

SEnsor

"Sensor type" is used to assign an application-specific sensor type to the detector.

The FE address required is first selected using the <Arrow keys>. Select the sensor selector box with
the <Tab key>, then select the "Sensor type" required with the <Cursor keys>.

The selection must then be confirmed with <Enter>. The relevant sensor is shown next to the FE
address.
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3.6.6.8 Analogue outputs configuration

General Control unit File Edit 9:27:34
I DETECTOR PARAMETERS
ANALOG OUTPUT ASSIGHHENT
Pos. AKGO Start End AK6D output
FE101 - 1] 1] 100 ——a Position 101
A 1301 4 AK6D 1]
A 1302 +
A 1303
A 1304 Start value 0]
A 1305 End value 100
A 1306
A 1307
A 1308 ¥ < 1] >
]
[« ok > |<cancer
S_anas
L Sensor
Note:

The "Analogue outputs" function is only enabled if an analogue card (AK60) has been defined in the
function "Hardware".( see 3.6.3)

An analogue output (4 - 20 mA) can then be assigned to each detector.
Parameterization operates as follows:
1. The appropriate FE address is first selected using the <Cursor keys>.

2. Change to the selector box showing the "Analogue outputs"” available using the
<Tab key>, then select the analogue output desired using the cursor keys.

3. The "Start value" and "End value" of the analogue output can be edited by pressing the <Tab
key> again.

4. The resolution can thus be changed as for the bar display. The function is saved by selecting the
"OK" button and confirming with <Enter>.
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3.6.6.9 Calibration gas concentration

General Control unit File

Edit
DETECTOR PARAMETERS

9.27:57

| ASSIGHHENT

| CONFIGURATION

| RETENTIOHN

CALIBRATION GAS

Pos.

ZERD

CAL .GAS

FE101 -

o

100

ZEro gas

Cal. gas

100

[ o]

(FE 101) |<

Ok >

<CANCEL>

5 _calg

SENSOr

This function defines the concentration of the "Zero gas" (purge) and the concentration of the "Cal.
Gas" (calibration gas bottle) for each sensor.

3.6.6.10 Set threshold values (WA/PA/AL)

General Control unit File Edit 9:28:720
DETECTOR PARAMETERS
| AssTGNMENT | | conFreuraTION | | rReTENTION
THRESHOLD UALUES
Pos. A PA AL
FE101 - 20 40 60
Warning 20
Prealarn 40
Alarnm 511}
« [JK =
(FE 10D [< 0Ok
CCANCEL>
s_level
L ]
Sensor

The threshold values (event levels) for each detector are defined using this function.
The following threshold values can be defined for each detector:

- Warning
- Prealarm
- Alarm (AL)

Recommendations for the threshold values can be found in the maintenance documentation.
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3.6.7 Copy function

The "Copy function" function does not become active until all detector parameters have been de-
fined.
General Control unit File Edit 9:78:46

DETECTOR : COPY FUNCTIOHN

MASTER DETECTOR FE| 101

From FE| 101 To FE| 101

[ o ]

(FE101) |< Ok >

<CANCEL>

S_Ccopy

All detector parameters with the exception of the "Assignment of the physical detector address to the
logical FE address" can be copied with the copy function.
Nor can the calibration data of the detectors be copied.

Zone parameters and assignments cannot be copied!
Copy procedure:

Select the "Master detector" with the <Tab key> and specify the appropriate, completely configured
Master detector.

Then use the <Tab key> again to select the From FE ... To FE ... function where you will have to enter
the FE addresses of the detectors into which the master data are to be imported.
The copy function is executed when the "OK" field is selected and confirmed with <Enter>.

Caution!

Detector parameters that have already been configured will be overwritten by
the copy function.
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3.6.8 Control zones

30

The function "Control zones" does not become active until the detector parameters have been de-

fined.
General Control uvunit File Edit 9:29:11

Z0NES - CONFIGURATION

DETECTOR-ASSIGHHENT RELAY ASSIGHHMENT ON/OFF DELAY

<Edit> {Edit> <Edit>

ALARM HOLD Z0NE ACTIVITY
ALARHM OUTPUT

<Edit> {Edit>

[[<conTTnuE |
group

All detector zone-specific parameters are defined under the function "Control zones".
The menu is used as follows:

Use the <Tab key> to select the field you wish to configure.
Then, confirming by pressing <Enter> takes you to the corresponding submenu.

Note: Parameterization must be carried out in sequence, i.e. first from left to right
and then from top to bottom.
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3.6.8.1 Detector assignment

General Control unit File Edit 9:29:43
Z0NES : DETECTOR ASSIGHHMENT
Zones Zone capability Associations Pos.
|
1 - UPAA & Warning [X1 Warning 1 101
2 - 4 Prealarn [¥]
3 - I Alarn [¥] Prealarn 1
4 —
5 - ¥ All [ 1 Alarm 1
]
Assignnents 0 : 1 FE : 101
»101
<< Assign <<
>> Remove > <CANCEL>
0_ass

The individual detectors are assigned to the control zones under detector assignment.
Parameterization is carried out as follows:
1. Use the <Cursor keys> to select the zone number to be configured.

2. Pressing the <Tab key> again takes you to the "Associations" field in which the
number of detectors which must reach the corresponding threshold value for the corresponding zo-
ne activity must be entered.
Caution: At least 1 must be entered to allow a zone to be activated.

3. The <Tab key> is pressed again to select the "ltems" field where the <Cursor keys> can be used
to select the detector which is to be assigned to the zone.

4. Press the <Tab key> to select the "Assign" field and confirm by pressing <Enter> Assignment to a
zone is indicated in the "Assign" field.

Note: If the "Splitting Flag" has been released in the CC60, you can shift to the
"Zone capability” using the <Tab key>. The <Cursor keys> and the
<Spacebar> can then be used to define the zone capability.

The assignment of detectors to a zone must be defined separately for each

detector, i.e. steps 3 and 4 must be repeated as many times as there are detectors in a
zone.

31

Siemens Building Technologies e1369e
Fire & Security Products 10.2002



3.6.8.2 Relay assignment

General Control uvunit File Edit

ZOHES : RELAY ASSIGHHENT

9:31:14

Zones Zone capability Relay messag Relay

» 1 WPAA 1201

Warning [ 1 PRT [¥1 1202

Prealarn [X1 1203

Alarm [ 1 DHS [ 1 1204

1205

1206

1207

Assignments Z0:01 REL:1201 1208

»1201 PA
<£ Assignment {<£ "« DK =
> Remove p <CANCEL>
g rel

Relays located on relay cards on the control unit BUS, can be assigned to the processes of defined
control zones using the function "Relay assignment".
It is only possible to assign relays which have been defined under the
function "Hardware" ( see 3.6.3)

Parameterization is carried out as follows:

1.

2.

Comment:

Use the <Cursor keys> to select the zone number to be configured.

Use <Tab key> to switch to the "Zone capability" field. Then you can use the

<Cursor keys> and the <Spacebar> to define the zones or Relay capability.

signed to the selected group with the Cursor keys.

Pressing the <Tab key> again takes you to the "Relay" field in which the relay desired can be as-

. Press the <Tab key> to select the "Assignment" field and confirm by pressing <Enter> Relay as-
sociations can be seen in the "Assignments" field.

3 and 4 must be repeated as many times as there are relays in a zone.
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3.6.8.3 On/ Off delay

General Control unit File Edit 9:32:10
Z0OHES : DELAY TIHES

Zone OnWA offuA OnPA offPA OnAL offAL

0 1 - ] o ] o ] o

Alarns [ Hin./10 1

ON Delay WA 0] O Delay PA 0] O Delay AL 0]
OFF Delay WA 0 OFF Delay PA 0 OFF Delay AL 0] "—
o« 1] 4 »
(20 1)|< Ok >
<CANCEL>
g_de lay

The on and off delays per zone and per event level are defined in this function.

The <Cursor keys> are used to select the control zone control zone to be configured from the "Zone"
field.

Pressing the <Tab key> takes the cursor to the selector box in which the times desired can be ente-
red in 6 second increment.

Once all times have been defined, the "OK" field can be selected with the <Tab key> and the para-
meters accepted by pressing <Enter>.

The energizing delay times and release delay times are shown in the upper selector box. The times
must be defined separately for each zone.
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3.6.8.4 Alarm hold

General Control uvunit File Edit 9:32:50
Z0HES : SELF-HOLD 7
Z0HE WA PA AL Self-hold
H 1 - H_ H_ SH Warning Yes C)
No (+)
Prealarnm Yes ()
No (+)
Alarn Yes (+)
NHo ()
||« oK =
(ZH 1)|< Ok >
<CANCEL>
g_hold
L group

The holds for the zones are configured in this menu. It is possible to specify for each zone whether
Warning, Pre-alarm and Alarm are self-holding or automatically resetting once the value has fallen
below a relevant threshold value.

The control zone which is to be configured is selected in the "Zone" field using the <Cursor keys>.
Pressing the <Tab key> changes into the "Self-hold" field, where the hold at each threshold value can

be configured by pressing the <Spacebar> The definition is stored by pressing <Enter> when the cur-
sor is in the "OK" field.
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3.6.8.5 Zone activity/ Alarm outputs

General Control unit File Edit 9:33:44
ZONES : ACTIVITY/ALARH
Zones WA PA AL ACT. Configuration
0 1 - D D . N Warning Prealarnm
PRT I 1 PRT I 1
DHS [X1 DHS [X1
NONE [ 1 HONE [ 1
Alarm
PRT I 1
Zone active Yes ()
Ho (+) [————————]
|« 0K »l
(20 1) |< Ok >
<CANCEL>
g_ala

This function is used to specify where the zone and relay messages are to be sent.
You may choose between no output message, message to the printer and message to DMS.

Use the <Cursor keys> to select from the "Zone" field the control zone which is to be configured.
Pressing the <Tab key> changes to the "Configuration” field where the criterion required can be spe-
cified by pressing the <Spacebar> . The definition is saved by pressing <Enter> with the cursor in the
"OK" field.

Parameterization must be carried out separately for each control zone.

PRT =  Printer
DMS = Management system
None = No output

Important: every control zone used must be set to Active "Yes" in the Configuration
field, otherwise the control zone has no function.

There must be at least 1 zone with all detectors, so that the relays on the SU60 become active in the
event of a WA, PA, AL activity.
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